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The Arria V, Cyclone V, and Stratix V support three types of transceiver PHY implementations or

customization.
The three types of transceiver PHY implementations are the following:

« Protocol-specific PHY
« Non-protocol-specific PHY
» Native transceiver PHY

1

The protocol-specific transceiver PHYs configure the PMA and PCS to implement a specific protocol. In
contrast, the native PHY provides broad access to the low-level hardware, allowing you to configure the
transceiver to meet your design requirements. Examples of protocol-specific PHYs include XAUI and
Interlaken.

You must also include the reconfiguration and reset controllers when you implement a transceiver PHY in
your design.

Protocol-Specific Transceiver PHYs

The protocol-specific transceiver PHYs configure many PCS to meet the requirements of a specific
protocol, leaving fewer parameters for you to specify.

Altera offers the following protocol-specific transceiver PHYS:

« 1G/10 Gbps Ethernet

o 10GBASE-R

o Backplane Ethernet I0GBASE-KR PHY
o Interlaken

o PHY IP Core for PCI Express (PIPE)

¢ XAUI

These transceiver PHYs include an Avalon® Memory-Mapped (Avalon-MM) interface to access control
and status registers and an Avalon Streaming (Avalon-ST) interface to connect to the MAC for data
transfer.

The following figure illustrates the top level modules that comprise the protocol-specific transceiver PHY
IP cores. As illustrated, the Altera Transceiver Reconfiguration Controller IP Core is instantiated
separately.

Intel Corporation. All rights reserved. Intel, the Intel logo, Altera, Arria, Cyclone, Enpirion, MAX, Nios, Quartus and Stratix words and logos are trademarks of

Intel Corporation or its subsidiaries in the U.S. and/or other countries. Intel warrants performance of its FPGA and semiconductor products to current 1SO
specifications in accordance with Intel's standard warranty, but reserves the right to make changes to any products and services at any time without notice. ~ 9001:2015
Intel assumes no responsibility or liability arising out of the application or use of any information, product, or service described herein except as expressly Registered

agreed to in writing by Intel. Intel customers are advised to obtain the latest version of device specifications before relying on any published information
and before placing orders for products or services.
*Other names and brands may be claimed as the property of others.

JALTERAN

101 Innovation Drive, San Jose, CA 95134 now part of Intel


https://www.altera.com/servlets/subscriptions/alert?id=UG-01080
mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20(UG-01080%202020.06.02)%20Introduction%20to%20the%20Protocol-Specific%20and%20Native%20Transceiver%20PHYs&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html

1-2 Native Transceiver PHYs

Figure 1-1: Transceiver PHY Top-Level Modules
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Native Transceiver PHYs

Each device family, beginning with Series V devices offers a separate Native PHY IP core to provide low-
level access to the hardware. There are separate IP Cores for Arria V, Arria V GZ, Cyclone V, and Stratix V

devices.

Avalon-MM master interface Avalon-MM slave interface

The Native PHYSs allow you to customize the transceiver settings to meet your requirements. You can also
use the Native PHYs to dynamically reconfigure the PCS datapath. Depending on protocol mode selected,
built-in rules validate the options you specify. The following figure illustrates the Stratix V Native PHY.
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Figure 1-2: Stratix V Transceiver Native PHY IP Core
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As shown, the Stratix V Native PHY connects to the separately instantiated Transceiver Reconfiguration
Controller and Transceiver PHY Reset Controller.

Table 1-1: Native Transceiver PHY Datapaths

I T

PMA Direct:

This datapath connects the
FPGA fabric directly to the
PMA, minimizing latency.
You must implement any
required PCS functions in the
FPGA fabric.

(&)

Stratix V ArriaV GZ Cyclone V
Yes Yes Yes -

()" PMA Direct mode is supported for Arria V GT, ST, and GZ devices, and for Stratix V GT devices only.
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Datapaths Stratix V Arria V GZ Cyclone V
Standard: Yes Yes Yes Yes
This datapath provides a
complete PCS and PMA for

the TX and RX channels. You
can customize the Standard
datapath by enabling or
disabling individual modules
and specifying data widths.

10G: Yes - Yes -

This is a high performance
datapath. It provides a
complete PCS and PMA for
the TX and RX channels. You
can customize the 10G
datapath by enabling or
disabling individual modules
and specifying data widths.

Related Information

+ Analog Settings for Arria V Devices on page 20-2

« Analog Settings for Arria V GZ Devices on page 20-11
« Analog Settings for Cyclone V Devices on page 20-26
+ Analog Settings for Stratix V Devices on page 20-35

Non-Protocol-Specific Transceiver PHYs

Non-protocol specific transceiver PHYs provide more flexible settings than the protocol-specific
transceiver PHYs. They include the Custom PHY, Low Latency PHY, and Deterministic Latency PHY IP
Cores.

These PHYs include an Avalon® Memory-Mapped (Avalon-MM) interface to access control and status
registers and an Avalon Streaming (Avalon-ST) interface to connect to the MAC for data transfer.

Related Information

o Custom PHY IP Core on page 10-1
o Deterministic Latency PHY IP Core on page 12-1
o Low Latency PHY IP Core on page 11-1

Transceiver PHY Modules

The following sections provide a brief introduction to the modules included in the transceiver PHYs.
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PCS

The PCS implements part of the physical layer specification for networking protocols. Depending upon
the protocol that you choose, the PCS may include many different functions. Some of the most commonly
included functions are: 8B/10B, 64B/66B, or 64B/67B encoding and decoding, rate matching and clock
compensation, scrambling and descrambling, word alignment, phase compensation, error monitoring,
and gearbox.

PMA

The PMA receives and transmits differential serial data on the device external pins. The transmit (TX)
channel supports programmable pre-emphasis and programmable output differential voltage (VOD). It
converts parallel input data streams to serial data. The receive (RX) channel supports offset cancellation to
correct for process variation and programmable equalization. It converts serial data to parallel data for
processing in the PCS. The PMA also includes a clock data recovery (CDR) module with separate CDR
logic for each RX channel.

Avalon-MM PHY Management Interface

You can use the Avalon-MM PHY Management module to read and write the control and status registers
in the PCS and PMA for the protocol-specific transceiver PHY. The Avalon-MM PHY Management
module includes both Avalon-MM master and slave ports and acts as a bridge. It transfers commands
received from an embedded controller on its slave port to its master port. The Avalon-MM PHY
management master interface connects the Avalon-MM slave ports of PCS and PMA registers and the
Transceiver Reconfiguration module, allowing you to manage these Avalon-MM slave components
through a simple, standard interface. (Refer to Transceiver PHY Top-Level Modules.)

Transceiver Reconfiguration Controller

Altera Transceiver Reconfiguration Controller dynamically reconfigures analog settings in Arria V,
Cyclone V, and Stratix V devices.

Reconfiguration allows you to compensate for variations due to process, voltage, and temperature (PVT)
in 28-nm devices. It is required for Arria V, Cyclone V, and Stratix V devices that include transceivers. For
more information about the Transceiver Reconfiguration Controller, refer to Transceiver Reconfiguration
Controller IP Core. The reset controller may be included in the transceiver PHY or may be a separately
instantiated component as described in Transceiver PHY Reset Controller.

Related Information

Transceiver Reconfiguration Controller IP Core Overview on page 17-1

Resetting the Transceiver PHY

This section provides an overview of the embedded reset controller and the separately instantiated
Transceiver PHY Reset Controller IP Core.

The embedded reset controller ensures reliable transceiver link initialization. The reset controller initial-
izes both the TX and RX channels. You can disable the automatic reset controller in the Custom, Low
Latency Transceiver, and Deterministic Latency PHYs. If you disable the embedded reset controller, the
powerdown, analog and digital reset signals for both the TX and RX channels are top-level ports of the
transceiver PHY. You can use these ports to design a custom reset sequence, or you can use the Altera-
provided Transceiver Reset Controller IP Core.
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The Transceiver PHY Reset Controller IP Core handles all reset sequencing of the transceiver to enable
successful operation. Because the Transceiver PHY Reset Controller IP is available in clear text, you can
also modify it to meet your requirements. For more information about the Transceiver PHY Reset
Controller, refer to Transceiver Reconfiguration Controller IP Core.

To accommodate different reset requirements for different transceivers in your design, instantiate multiple
instances of a PHY IP core. For example, if your design includes 20 channels of the Custom PHY IP core
with 12 channels running a custom protocol using the automatic reset controller and 8 channels requiring
manual control of RX reset, instantiate 2 instances of the Custom PHY IP core and customize one to use
automatic mode and the other to use your own reset logic. For more information, refer to “Enable
embedded reset control” in Custom PHY General Options.

For more information about reset control in Stratix V devices, refer to Transceiver Reset Control in Stratix
V Devices in volume 3 of the Stratix V Device Handbook. For Stratix IV devices, refer to Reset Control and
Power Down in volume 4 of the Stratix IV Device Handbook. For Arria V devices, refer to Transceiver Reset
Control and Power-Down in Arria V Devices. For Cyclone V devices refer to Transceiver Reset Control and
Power Down in Cyclone V Devices.

Related Information

« General Options Parameters on page 10-3

« Transceiver PHY Reset Controller IP Core on page 18-1

o Transceiver Reset Control in Stratix V Devices

« Reset Control and Power Down

o Transceiver Reset Control and Power-Down in Arria V Devices

o Transceiver Reset Control and Power Down in Cyclone V Devices

Running a Simulation Testbench

When you generate your transceiver PHY IP core, the Intel® Quartus® Prime software generates the HDL
files that define your parameterized IP core. In addition, the Intel Quartus Prime software generates an
example Tcl script to compile and simulate your design in ModelSim.

Altera Corporation Introduction to the Protocol-Specific and Native Transceiver PHYs
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Figure 1-3: Directory Structure for Generated Files

[ <project_dir>

<instance_name>. v or .vhd - the parameterized transceiver PHY IP core

<instance_name> .qip - lists all files used in the transceiver PHY IP design
<instance_name> .bsf -a block symbol file for you transceiver PHY IP core

<project_dir>/<instance_name> - includes PHY IP Verilog HDL and
SystemVerilog design files for synthesis

<instance_name> _sim/altera_xcvr <PHY_IP_name> -includes plain text
files that describe all necessary files required for a successful simulation. The
plain text files contain the names of all required files and the correct order

for reading these files into your simulation tool.

™ <instance_name> _sim/aldec -
Simulation files for Riviera-PRO simulation tools

E] <instance_name> _sim/cadence -
Simulation files for Cadence simulation tools

E] <instance_name> _sim/mentor -
Simulation files for Mentor simulation tools

(" <instance_name> _sim/synopsys -
Simulation files for Synopsys simulation tools

The following table describes the key files and directories for the parameterized transceiver PHY IP core
and the simulation environment which are in clear text.

Table 1-2: Transceiver PHY Files and Directories

I == R I

<project_dir> The top-level project directory.

<instance_name> .v or .vhd The top-level design file.

<instance_name> .qip A list of all files necessary for Intel Quartus Prime
compilation.

<instance_name> .bsf A Block Symbol File (.bsf) for your transceiver PHY.

<project_dir>/<instance_name>/ The directory that stores the HDL files that define
the protocol-specific PHY IP core. These files are
used for synthesis.

Introduction to the Protocol-Specific and Native Transceiver PHYs Altera Corporation
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I == R I

SV_XCVr_native.sv

Defines the transceiver. It includes instantiations of
the PCS and PMA modules and Avalon-MM PHY
management interface.

stratixv_hssi_ <module_name> rbc. sv

These files perform rule based checking for the
module specified. For example, if the PLL type, data
rate, and FPGA fabric transceiver interface width
are not compatible, the checker reports an error.

altera_wait_generate.v

Generates waitrequest for protocol-specific
transceiver PHY IP core that includes backpressure.

alt_reset_ctrl_tgx_cdrauto.sv

Includes the reset controller logic.

<instance_name> _phy_assignments.qip

Includes an example of the PLL_TYPE assignment
statement required to specify the PLL type for each
PLL in the design. The available types are clock
multiplier unit (CMU) and auxiliary transmit
(ATX).

<project_dir>/<instance_name> _sim/ altera_xcvr_
<PHY_IP_name>/

The simulation directory.

<project_dir>/<instance_name>_sim/ aldec

Simulation files for Riviera-PRO simulation tools.

<project_dir>/<instance_name>_sim/ cadence

Simulation files for Cadence simulation tools.

<project_dir>/<instance_name>_sim/ mentor

Simulation files for Mentor simulation tools.

<project_dir>/<instance_name>_sim/ synopsys

Simulation files for Synopsys simulation tools.

The Verilog and VHDL transceiver PHY IP cores have been tested with the following simulators:

o ModelSim SE
o Synopsys VCS MX
e Cadence NCSim

If you select VHDL for your transceiver PHY, only the wrapper generated by the Intel Quartus Prime
software is in VHDL. All the underlying files are written in Verilog or System Verilog.

For more information about simulating with ModelSim, refer to the Mentor Graphics ModelSim and
QuestaSim Support chapter of the Intel Quartus Prime Handbook.

The transceiver PHY IP cores do not support the NativeLink feature in the Intel Quartus Prime software.

Generating Custom Simulation Scripts for Multiple Transceiver PHYs with ip-make-simscript

Use the ip-make-simscript utility to generate simulation command scripts for multiple transceiver
PHYs or Qsys systems. Specify all Simulation Package Descriptor files (.spd). The .spd files list the
required simulation files for the corresponding IP core. The MegaWizard Plug-In Manager and Qsys

generate the .spd files.

When you specify multiple .spd files, the ip-make-simscript utility generates a single simulation script
containing all required simulation information. The default value of TOP_LEVEL_NAME is the

Altera Corporation
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TOP_LEVEL_NAME defined in the IP core or Qsys .spd file. If this is not the top-level instance in your design,
specify the top-level instance of your testbench or design.

You can set appropriate variables in the script or edit the variable assignments directly in the script. If the
simulation script is a Tcl file that can be sourced in the simulator, set the variables before sourcing the
script. If the simulation script is a shell script, pass in the variables as command-line arguments to shell

script.

To run ip-make-simscript, type the following at the command prompt:

<ACDS install ation pat h>\quartus\sopc_builder\bin\ip-make-simscript

The following tables lists some of the options available with this utility.

Table 1-3: Options for the i p- make- si mscri pt Utility

T T T

--spd=<file> Describes the list of compiled files and Requir
memory model hierarchy. If your design ed
includes multiple IP cores or Qsys systems
that include .spd files, use this option for
each file. For example:
ip-make-simscript --spd=ipl.spd --
spd=ip2.spd

—elilpi= Directory path specifying the location of Option

directory=<directory> | ouput files. If unspecified, the default setting | 2l
is the directory from which ip-make-
simscriptis run.

--compile-to-work Compiles all design files to the default work | Option
library. Use this option only if you encounter al
problems managing your simulation with
multiple libraries.

--use-relative-paths | Uses relative paths whenever possible Option

al

To learn about all options for the ip-make-simscript, type the following at the command prompt:

<ACDS install ation pat h>\quartus\sopc_builder\bin\ip-make-simscript --help

Related Information

o Mentor Graphics ModelSim Support

o Simulating Altera Designs

Unsupported Features

The protocol-specific and native transceiver PHY's are not supported in Qsys in the current release.
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This chapter provides a general overview of the Altera IP core design flow to help you quickly get started
with any Altera IP core.

The Altera IP Library is installed as part of the Intel Quartus Prime installation process. You can select and
parameterize any Altera IP core from the library. Altera provides an integrated parameter editor that
allows you to customize IP cores to support a wide variety of applications. The parameter editor guides
you through the setting of parameter values and selection of optional ports. The following sections
describe the general design flow and use of Altera IP cores.

Installation and Licensing of IP Cores

The Altera IP Library is distributed with the Intel Quartus Prime software and downloadable from the
Altera website.

The following figure shows the directory structure after you install an Altera IP core, where <path> is the
installation directory. The default installation directory on Windows is C:\altera\<version number>; on
Linux it is /opt/altera<version number>.

Figure 2-1: IP Core Directory Structure

D <path>
Installation directory

i
Contains the Altera IP Library and third-party IP cores

altera
Contains the Altera IP Library

alt_mem_if
Contains the UniPHY IP core files

You can evaluate an IP core in simulation and in hardware until you are satisfied with its functionality and
performance. Some IP cores require that you purchase a license for the IP core when you want to take your
design to production. After you purchase a license for an Altera IP core, you can request a license file from
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the Altera Licensing page of the Altera website and install the license on your computer. For additional
information, refer to Altera Software Installation and Licensing.

Related Information

o Altera
o Altera Licensing
o Altera Software Installation and Licensing

Design Flows

This section describes how to parameterize Altera IP cores.

You can use the following flow(s) to parameterize Altera IP cores:
Figure 2-2: Design Flows

@

Select Design Flow

Qsys or l
SOPC Builder MegaWizard
Flow Flow
Specify Parameters Specify Parameters
Complete Qsys or
SOPC Builder System

|
Optional

: :

Perform Yes Add Constraints
Functional Simulation and Compile Design

IP Complete

Does
Simulation Give
Expected Results?

Debug Design

@) Altera IP cores may or may not support the Qsys and SOPC Builder design flows.
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The MegaWizard Plug-In Manager flow offers the following advantages:

« Allows you to parameterize an IP core variant and instantiate into an existing design
« For some IP cores, this flow generates a complete example design and testbench

MegaWizard Plug-In Manager Flow

This section describes how to specify parameters and simulate your IP core with the MegaWizard Plug-In
Manager.

The MegaWizard™ Plug-In Manager flow allows you to customize your IP core and manually integrate the
function into your design.

Specifying Parameters

To specify IP core parameters, follow these steps:

1. Create a Intel Quartus Prime project using the New Project Wizard available from the File menu.

2. In the Intel Quartus Prime software, launch the IP Catalog.

3. You can select the IP core for your protocol implementation from the IP Catalog.

4. Specify the parameters on the Parameter Settings pages. For detailed explanations of these parameters,

refer to the "Parameter Settings" chapter in this document or the "Documentation" button in the
MegaWizard parameter editor.

Note: Some IP cores provide preset parameters for specific applications. If you wish to use preset
parameters, click the arrow to expand the Presets list, select the desired preset, and then click
Apply. To modify preset settings, in a text editor modify the <installation directory>/ip/altera/
alt_mem_if interfaces/alt_mem_if <memory_protocol>_emif/
alt_mem_if <memory_protocol>_mem_model.qprs file.
5. If the IP core provides a simulation model, specify appropriate options in the wizard to generate a
simulation model.

Note: « Altera IP supports a variety of simulation models, including simulation-specific IP functional
simulation models and encrypted RTL models, and plain text RTL models. These are all
cycle-accurate models. The models allow for fast functional simulation of your IP core
instance using industry-standard VHDL or Verilog HDL simulators. For some cores, only the
plain text RTL model is generated, and you can simulate that model.

 For more information about functional simulation models for Altera IP cores, refer to
Simulating Altera Designs in volume 3 of the Intel Quartus Prime Handbook.

Caution: Use the simulation models only for simulation and not for synthesis or any other purposes.
Using these models for synthesis creates a nonfunctional design.

6. If the parameter editor includes EDA and Summary tabs, follow these steps:
a. Some third-party synthesis tools can use a netlist that contains the structure of an IP core but no

detailed logic to optimize timing and performance of the design containing it. To use this feature if
your synthesis tool and IP core support it, turn on Generate netlist.

b. On the Summary tab, if available, select the files you want to generate. A gray checkmark indicates
a file that is automatically generated. All other files are optional.
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Note: If file selection is supported for your IP core, after you generate the core, a generation report
(<variation name>.html)appears in your project directory. This file contains information
about the generated files.

7. Click the Finish button, the parameter editor generates the top-level HDL code for your IP core, and a
simulation directory which includes files for simulation.

Note: The Finish button may be unavailable until all parameterization errors listed in the messages
window are corrected.

8. Click Yes if you are prompted to add the Intel Quartus Prime IP File (.qip) to the current Intel Quartus
Prime project. You can also turn on Automatically add Intel Quartus Prime IP Files to all projects.

You can now integrate your custom IP core instance in your design, simulate, and compile. While
integrating your IP core instance into your design, you must make appropriate pin assignments. You can
create a virtual pin to avoid making specific pin assignments for top-level signals while you are simulating
and not ready to map the design to hardware.

For some IP cores, the generation process also creates complete example designs. An example design for
hardware testing is located in the < variation_name > _example_design/example_project/ directory. An
example design for RTL simulation is located in the < variation_name > _example_design/simulation/
directory.

Note: For information about the Intel Quartus Prime software, including virtual pins, refer to Intel
Quartus Prime Help.

Related Information

« Simulating Altera Designs
o Intel Quartus Prime Help

Simulate the IP Core

This section describes how to simulate your IP core.

You can simulate your IP core variation with the functional simulation model and the testbench or
example design generated with your IP core. The functional simulation model and testbench files are
generated in a project subdirectory. This directory may also include scripts to compile and run the
testbench.

For a complete list of models or libraries required to simulate your IP core, refer to the scripts provided
with the testbench.

For more information about simulating Altera IP cores, refer to Simulating Altera Designs in volume 3 of
the Intel Quartus Prime Handbook.

Related Information

Simulating Altera Designs

Altera Corporation Getting Started Overview
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The Altera 10GBASE-R PHY IP Core implements the functionality described in IEEE Standard 802.3

Clause 45.

It delivers serialized data to an optical module that drives optical fiber at a line rate of 10.3125 gigabits per
second (Gbps). In a multi-channel implementation of I0GBASE-R, each channel of the I0GBASE-R PHY
IP Core operates independently. Both the PCS and PMA of the I0GBASE-R PHY are implemented as hard

IP blocks in Stratix V devices, saving FPGA resources.

Figure 3-1: T0GBASE-R PHY with Hard PCS with PMA in Stratix V Devices

Stratix V FPGA

SDR XGMII
72 bits @ 156.25 Mbps

10GBASE-R PHY IP Core

¢

L

Avalon-MM
Control & Status

Hard PCS
10GBASE-R

64b/66b
Scrambler
Gearbox

PMA

XFI/SFP+
10.3125 Gbps serial

Transceiver
Reconfiguraiton

Note: For a 10-Gbps Ethernet solution that includes both the Ethernet MAC and the 10GBASE-R PHY,

refer to the 10-Gbps Ethernet MAC MegaCore Function User Guide.

Note: For more detailed information about the I0GBASE-R transceiver channel datapath, clocking, and
channel placement, refer to the “10GBASE-R” section in the Transceiver Configurations in Stratix V
Devices chapter of the Stratix V Device Handbook.

The following figure illustrates a multiple 10 GbE channel IP core in a Stratix IV GT device. To achieve
higher bandwidths, you can instantiate multiple channels. The PCS is available in soft logic for Stratix IV
GT devices; it connects to a separately instantiated hard PMA. The PCS connects to an Ethernet MAC via
single data rate (SDR) XGMII running at 156.25 megabits per second (Mbps) and transmits data to a 10
Gbps transceiver PMA running at 10.3125 Gbps in a Stratix IV GT device.
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To make the most effective use of this soft PCS and PMA configuration for Stratix IV GT devices, you can
group up to four channels in a single quad and control their functionality using one Avalon-MM PHY
management bridge, transceiver reconfiguration module, and low controller. As this figure illustrates, the
Avalon-MM bridge Avalon-MM master port connects to the Avalon-MM slave port of the transceiver
reconfiguration and low latency controller modules so that you can update analog settings using the
standard Avalon-MM interface.

Note: This configuration does not require that all four channels in a quad run the 10GBASE-R protocol.
Figure 3-2: Complete T0GBASE-R PHY Design in Stratix IV GT Device

10GBASE-R PHY - Stratix [V Device
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Controller bhY. Controller
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Management . m
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The following figures illustrate the 10GBASE-R in Arria V GT, Arria V GZ, and Stratix V GX devices.

Altera Corporation 10GBASE-R PHY IP Core
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Figure 3-3: 10GBASE-R PHY IP Core In Arria V GT Devices
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Figure 3-4: 10GBASE-R PHY IP Core In Arria V GZ Devices

Avalon-ST

UG-01080
2020.06.02

Streaming

Data <«
Control & Status

(Optional or by
I/F Specification)

Avalon-MM
Management
Interface
to Embedded
Controller

Altera Corporation

Transceiver Protocol
Arria V GZ Transceiver Protocol
P Tx Data PCS PMA Generic
Rx Data PLL
V[v’.a.ta PLD-PCS & Duplex PCS TXPMA
. o nng PCS-PMA Tx Serial
>+ ¢ RX PMA & (DR Rx Serial
—o
* To/F
Reset < p-| PMA + Reset Control & Status X(E/Wzom
Controller (Memory Map)
“ Avalon-MM Master Transceiver
Reconfiguration
Controller

10GBASE-R PHY IP Core

C] Send Feedback


mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%2010GBASE-R%20PHY%20IP%20Core%20(UG-01080%202020.06.02)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

UG-01080 35
2020.06.02 T0GBASE-R PHY IP Core A

Figure 3-5: 10GBASE-R PHY IP Core In Stratix V Devices
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The following table lists the latency through the PCS and PMA for Arria V GT devices with a 66-bit PMA.
The FPGA fabric to PCS interface is 64 bits wide. The frequency of the parallel clock is 156.25 MHz which
is line rate (10.3125 Gpbs)/interface width (64).

Table 3-1: Latency for TX and RX PCS and PMA Arria V Devices

_ PCS (Parallel Clock Cycles PMA (UI)

TX 28 131
RX 33 99

The following table lists the latency through the PCS and PMA for Stratix V devices with a 40-bit PMA.
The FPGA fabric to PCS interface is 64 bits wide. The frequency of the parallel clock is 156.25 MHz which
is line rate (10.3125 Gbps)/interface width (64).

10GBASE-R PHY IP Core Altera Corporation
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Table 3-2: Latency for TX and RX PCS and PMA Stratix V Devices

PCS (Parallel Clock Cycles)
32-bit PMA Width 40-bit PMA Width PMA (UI)
X 7 12 8 12 124

RX 14 33 15 34 43

Related Information

« IEEE 802.3 Clause 49
« 10-Gbps Ethernet MAC MegaCore Function User Guide
» Transceiver Configurations in Stratix V Devices

10GBASE-R PHY Release Information
Release information for the IP core.

Table 3-3: 1T0GBASE-R Release Information

I R

Version 13.1

Release Date November 2013

Ordering Codes® IP-10GBASERPCS (primary) IPR-10GBASERPCS
(renewal)

Product ID 00D2

Vendor ID 6AF7

10GBASE-R PHY Device Family Support

Device support for the IP core.

IP cores provide either final or preliminary support for target Altera device families. These terms have the
following definitions:

o Final support—Verified with final timing models for this device.
o Preliminary support— Verified with preliminary timing models for this device.

) No ordering codes or license files are required for Stratix V devices.

Altera Corporation T10GBASE-R PHY IP Core
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Table 3-4: Device Family Support

Arria V GT devices-Soft PCS and Hard PMA Final
Arria V ST devices-Soft PCS and Hard PMA Final
ArriaV GZ Final

Stratix IV GT devices—Soft PCS and Hard PMA Final

Stratix V devices—Hard PCS and PMA Final

Other device families No support

Note: For speed grade information, refer to “Transceiver Performance Specifications” in the DC and
Switching Characteristics chapter in the Stratix IV Handbook for Stratix IV devices or Stratix V
Device Datasheet.

Related Information

» DC and Switching Characteristics
 Stratix V Device Datasheet.

10GBASE-R PHY Performance and Resource Utilization for Stratix IV
Devices

Because the 10GBASE-R PHY is implemented in hard logic it uses less than 1% of the available ALMs,
memory, primary and secondary logic registers. The following table lists the typical expected device
resource utilization for duplex channels using the current version of the Intel Quartus Prime software
targeting a Stratix IV GT device. The numbers of combinational ALUTSs, logic registers, and memory bits
are rounded to the nearest 100.

Table 3-5: T0GBASE-R PHY Performance and Resource Utilization—Stratix IV GT Device

1

5200 4100 4700
4 15600 1300 18800
10 38100 32100 47500

10GBASE-R PHY Performance and Resource Utilization for Arria V GT
Devices

The following table lists the resource utilization when targeting an Arria V (5AGTFD7K3F4015) device.

Resource utilization numbers reflect changes to the resource utilization reporting starting in the Quartus
IT software v12.1 release for 28 nm device families and upcoming device families. The numbers of ALMs
and logic registers are rounded up to the nearest 100.

10GBASE-R PHY IP Core Altera Corporation
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Devices
Note: For information about Intel Quartus Prime resource utilization reporting, refer to Fitter Resources

Reports in the Intel Quartus Prime Help.

Table 3-6: 1T0GBASE-R PHY Performance and Resource Utilization—Arria V GT Device

Channels ALMs Primary Logic Secondary Logic Memory 10K
Registers Registers

‘ 2800 ‘ 3000 ‘ 300

Related Information

Fitter Resources Reports

10GBASE-R PHY Performance and Resource Utilization for Arria V GZ and
Stratix V Devices

Because the I0GBASE-R PHY is implemented in hard logic in Arria V GZ and Stratix V devices, it uses
less than 1% of the available ALMs, memory, primary and secondary logic registers.

The following table lists the total latency for an Ethernet packet with a 9600 byte payload and an inter-
packet gap of 12 characters. The latency includes the number of cycles to transmit the payload from the
TX XGMII interface, through the TX PCS and PMA, looping back through the RX PMA and PCS to the
RX XGMII interface. (Stratix V Clock Generation and Distribution illustrates this datapath.)

Table 3-7: Latency

0 PPM 35
-200 PPM 35
+200 PPM 42

Note: If latency is critical, Altera recommends designing your own soft I0GBASE-R PCS and connecting
to the Low Latency PHY IP Core.

Parameterizing the 1T0GBASE-R PHY

The 10GBASE-R PHY IP Core is available for the Arria V, Arria V GZ, Stratix IV, or Stratix V device
families. Complete the following steps to configure the 10GBASE-R PHY IP Core:

Under Tools > IP Catalog, select the device family of your choice.
Under Tools > IP Catalog > Interface Protocols > Ethernet > select 10GBASE-R PHY.
Use the tabs on the MegaWizard Plug-In Manager to select the options required for the protocol.

Ll

Refer to the following topics to learn more about the parameters:

a. General Option Parameters on page 3-9

b. Analog Parameters for Stratix IV Devices on page 3-12

5. Click Finish to generate your parameterized 10GBASE-R PHY IP Core.

Altera Corporation 10GBASE-R PHY IP Core
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General Option Parameters

This section describes general parameters.

This section describes the I0GBASE-R PHY parameters, which you can set using the MegaWizard Plug-In
Manager.

Table 3-8: General Options

I N

General Options

Device family Arria V Specifies the target device.
ArriaV GZ
Stratix IV GT
Stratix V
Number of channels 1-32 The total number of I0GBASE-R PHY channels.
Mode of operation Duplex Arria V and Stratix V devices allow duplex, TX, or
RX mode. Stratix IV GT devices only support duplex
TX Only mode.
RX Only
PLL type CMU, ATX For Arria V GZ, Stratix I'V, and Stratix V devices:

You can select either the CMU or ATX PLL. The
CMU PLL has a larger frequency range than the
ATX PLL. The ATX PLL is designed to improve jitter
performance and achieves lower channel-to-channel
skew. Another advantage of the ATX PLL is that it
does not use a transceiver channel, while the CMU

PLL does.
Altera recommends the ATX PLL for data rates <=8
Gbps.
Reference Clock Frequency 322.265625 Arria V and Stratix V devices support both frequen-

MHz cies. Stratix IV GT devices only support 644.53125
MHz.

644.53125 MHz

10GBASE-R PHY IP Core Altera Corporation
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PCS / PMA interface width

32
40

For Stratix V and Arria V GZ devices only:

Specifies the data interface width between the 10G
PCS and the transceiver PMA. Smaller width
corresponds to lower PCS latency but higher
frequency.

o For 40 bit width, rx_recovered_clock is 257.8125
MHz and the gearbox ratio is 66:40.

o For 40 bit width, rx_recovered_clock is
322.265626 MHz and the gearbox ratio is 66:32.

32 bit PCS / PMA interface with does not support
data rates up to 10.3125 Gbps in C4/14 Arria V GZ
device variants. Refer to Arria V GZ Device
Datasheet for details on data rates supported by
different device variants.

Addition

al Options

Enable additional control and
status pins

On/Off

If you turn this option On, the following 2 signals are
brought out to the top level of the IP core to facilitate
debugging: rx_hi_ber and rx_block_lock.

Enable rx_recovered_clk pin

On/Off

When you turn this option On, the RX recovered
clock signal is an output signal.

Enable pll_locked status port

On/Off

For Arria V and Stratix V devices:

When you turn this option On, a PLL locked status
signal is included as a top-level signal of the core.

Use external PMA control and
reconfig

On/Off

For Stratix IV devices:

If you turn this option on, the PMA controller and
reconfiguration block are external, rather than
included in the 10GBASE-R PHY IP Core, allowing
you to use the same PMA controller and reconfigu-
ration IP cores for other protocols in the same
transceiver quad.

When you turn this option On, the cal_blk_
powerdown (0x021) and pma_tx_pll_is_locked
(0x022) registers are available.

Enable rx_coreclkin port

On/Off

When selected, rx_coreclkin is sourced from the
156.25 MHz xgmii_rx_clk signal avoiding the use
of a FPLL to generate this clock. This clock drives the
read side of RX FIFO.

Altera Corporation

10GBASE-R PHY IP Core

C] Send Feedback


mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%2010GBASE-R%20PHY%20IP%20Core%20(UG-01080%202020.06.02)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

UG-01080

2020.06.02 General Option Parameters 3-11
o e T g~
Enable embedded reset control | On/Off When On, the automatic reset controller initiates the

reset sequence for the transceiver. When Off you can
design your own reset logic using tx_analogreset,
rx_analogreset, tx_digitalreset, rx_digital-
reset, and pl1_powerdown which are top-level ports
of the Custom Transceiver PHY. You may also use
the Transceiver PHY Reset Controller to reset the
transceivers. For more information, refer to the
Transceiver Reconfiguration Controller IP Core . By
default, the CDR circuitry is in automatic lock mode
whether you use the embedded reset controller or
design your own reset logic. You can switch the CDR
to manual mode by writing the pma_rx_setlockto-
data or pma_rx_set_locktoref registers to 1. If
either the pma_rx_set_locktodata and pma_rx_
set_locktoref is set, the CDR automatic lock mode
is disabled.

Starting channel number 0-96 For Stratix IV devices, specifies the starting channel

number. Must be 0 or a multiple of 4. You only need
to set this parameter if you are using external PMA
and reconfiguration modules.

In Stratix V devices, by default, the logical channel 0
is assigned to either physical transceiver channel 1 or
channel 4 of a transceiver bank. However, if you have
already created a PCB with a different lane
assignment for logical channel 0, you can use the
work around shown in the example below.

Assignment of the starting channel number is
required for serial transceiver dynamic reconfigura-
tion.

Enable IEEE 1588 latency On/Off When you turn this option On, the core includes
adjustment ports logic to implement the IEEE 1588 Precision Time
Protocol.

Example 3-1: Changing the Default Logical Channel 0 Channel Assignments in Stratix V Devices
for x6 or xN Bonding

This example shows how to change the default logical channel 0 assignment in Stratix V devices by
redefining the pma_bonding master parameter using the Intel Quartus Prime Assignment Editor.
In this example, the pma_bonding master was originally assigned to physical channel 1. (The
original assignment could also have been to physical channel 4.) The to parameter reassigns the

T10GBASE-R PHY IP Core Altera Corporation
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pma_bonding master to the 10GBASE-R instance name. You must substitute the instance name
from your design for the instance name shown in quotation marks.

set_parameter -name pma_bonding_master "\""1\"" -to "<PHY IP instance name>"

Related Information

o Transceiver PHY Reset Controller IP Core on page 18-1

« 1588 Delay Requirements on page 3-29
o Arria V GZ Device Datasheet

Analog Parameters for Stratix IV Devices

For Stratix IV devices, you specify analog options on the Analog Options tab.

Table 3-9: PMA Analog Options for Stratix IV Devices

e R i

Transmitter termination
resistance

OCT_85_OHMS,

OCT_100_OHMS,
OCT_120_OHMS,
OCT_150_OHMS

Indicates the value of the termination resistor for
the transmitter.

Transmitter Vgp control |0-7 Sets Vp for the various TX buffers.

setting

Pre-emphasis pre-tap 0-7 Sets the amount of pre-emphasis on the TX buffer.

setting

Invert the pre.-emph.asis On, Off Determines whether or not the pre-emphasis

pre-tap polarity setting control signal for the pre-tap is inverted. If you
turn this option on, the pre-emphasis control
signal is inverted.

Pre-emphasis first post- | 0-15 Sets the amount of pre-emphasis for the 1st post-

tap setting tap.

Pre-emphasis second 0-7 Sets the amount of pre-emphasis for the 2nd post-

post-tap setting tap.

Invert the pre-emphasis | On, Off Determines whether or not the pre-emphasis

second post-tap polarity

control signal for the second post-tap is inverted. If
you turn this option on, the pre-emphasis control
signa is inverted.

Altera Corporation
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Receiver common mode | Tyi_State Specifies the RX common mode voltage.
voltage
0.82V
1.1v
Receiver termination OCT 85 OHMS Indicates the value of the termination resistor for
resistance T the receiver.

OCT_100_OHMs
OCT_120_OHMS
OCT_150_OHMS

Receiver DC 0-4 Sets the equalization DC gain using one of the
following settings:

« 0:0dB
e 1:3dB
e 2:6dB
e 3:9dB
e 4:12dB

Receiver static equalizer |0-15 This option sets the equalizer control settings. The
setting: equalizer uses a pass band filter. Specifying a low
value passes low frequencies. Specifying a high
value passes high frequencies.

Analog Parameters for Arria V, Arria V GZ, and Stratix V Devices

Click on the appropriate links to review the analog parameters for these devices.

Related Information

« Analog Settings for Arria V Devices on page 20-2
» Analog Settings for Arria V GZ Devices on page 20-11
« Analog Settings for Stratix V Devices on page 20-35

10GBASE-R PHY Interfaces
This section describes the I0GBASE-R PHY interfaces.
The following figure illustrates the top-level signals of the 10BASE-R PHY; <#n> is the channel number.

10GBASE-R PHY IP Core Altera Corporation
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3-14 10GBASE-R PHY Data Interfaces

Figure 3-6: 10GBASE-R PHY Top-Level Signals
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Note: The block diagram shown in the GUI labels the external pins with the interface type and places the

interface name inside the box. The interface type and name are used in the Hardware Component
Description File (_hw.tcl). If you turn on Show signals, the block diagram displays all top-level
signal names.

For more information about _hw.tcl files refer to refer to the Component Interface Tcl Reference chapter in

volume 1 of the Intel Quartus Prime Handbook.

Related Information

Component Interface Tcl Reference

10GBASE-R PHY Data Interfaces

This section describes the I0GBASE-R PHY data interfaces.
The TX signals are driven from the MAC to the PCS. The RX signals are driven from the PCS to the MAC.

Table 3-10: SDR XGMII TX Inputs

XGMII TX Interface

Altera Corporation

10GBASE-R PHY IP Core
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xgmii_tx_dc_[<n>71:0] Input Contains 8 lanes of data and control for
XGMII. Each lane consists of 8 bits of data and
1 bit of control.

o Lane 0-[7:0]/[8]

e Lane 1-[16:9]/[17]
o Lane2-[25:18]/[26
o Lane 3-[34:27]/[35
o Lane 4-[43:36]/[44
o Lane 5-[52:45]/[53
1/
1/

10GBASE-R PHY Data Interfaces 3-15

o Lane 6-[61:54]/[62
o Lane 7-[70:63]/[71

—_— e =

Refer toTable 3-11 for the mapping of the
xgmii_tx_dc data and control to the xgmii_
sdr_data and xgmi i_sdr_ctrl signals.

tx_ready Output Asserted when the TX channel is ready to
transmit data. Because the readylLatency on
this Avalon-ST interface is 0, the MAC may
drive tx_ready as soon as it comes out of reset.

xgmii_tx_clk Input The XGMII TX clock which runs at 156.25
MHz. Connect xgmii_tx_clk to xgmii_rx_
clk to guarantee this clock is within 150 ppm
of the transceiver reference clock.

XGMII RX Interface

xgmii_rx_dc_<n>[71:0] Output Contains 8 lanes of data and control for
XGMII. Each lane consists of 8 bits of data and
1 bit of control.

o Lane 0-[7:0]/[8]

e Lane 1-[16:9]/[17]

o Lane 2-[25:18]/[26]

o Lane 3-[34:27]/[35]

o Lane 4-[43:36]/[44]

o Lane 5-[52:45]/[53]

o Lane 6-[61:54]/[62]

o Lane 7-[70:63]/[71]

Refer toTable 3-12 for the mapping of the

xgmii_rx_dc data and control to the xgmii_
sdr_data and xgmi i_sdr_ctrl signals.

rx_ready Output Asserted when the RX reset is complete.

T10GBASE-R PHY IP Core Altera Corporation
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rx_data_ready [<n>-1:0]

Output

When asserted, indicates that the PCS is
sending data to the MAC. Because the
readyLatency on this Avalon-ST interface is 0,
the MAC must be ready to receive data
whenever this signal is asserted. After rx_
ready is asserted indicating the exit from the
reset state, the MAC should store xgmii_rx_
dc_<n>[71:0] in each cycle where rx_data_
ready<n> is asserted.

xgmii_rx_clk

Output

This clock is generated by the same reference
clock that is used to generate the transceiver
clock. Its frequency is 156.25 MHz. Use this

clock for the MAC interface to minimize the
size of the FIFO between the MAC and SDR
XGMII RX interface.

rx_coreclkin

Input

When you turn on Create rx_coreclkin port,
this signal is available as a 156.25 MHz clock
input port to drive the RX datapath interface
(RX read FIFO).

Serial Interface

rx_serial_data_<n> Input Differential high speed serial input data using
the PCML I/O standard. The clock is recovered
from the serial data stream.

tx_serial_data_<n> Output Differential high speed serial input data using

the PCML I/O standard. The clock is
embedded from the serial data stream.

Table 3-11: Mapping from XGMII TX Bus to XGMII SDR Bus

xgmii_tx_dc_[7:0]

xgmii_sdr_data[7:0]

Lane 0 data

xgmii_tx_dc_[8]

xgmii_sdr_ctrl[0]

Lane 0 control

xgmii_tx_dc_[16:9]

xgmii_sdr_data[15:

8]

Lane 1 data

xgmii_tx_dc_[17]

xgmii_sdr_ctri[1]

Lane 1 control

xgmii_tx_dc_[25:18]

xgmii_sdr_data[23:

16]

Lane 2 data

xgmii_tx_dc_[26]

xgmii_sdr_ctri[2]

Lane 2 control

xgmii_tx_dc_[34:27]

xgmii_sdr_data[31:

24]

Lane 3 data

xgmii_tx_dc_[35]

xgmii_sdr_ctrl[3]

Lane 3 control

xgmii_tx_dc_[43:36]

xgmii_sdr_data[39:

32]

Lane 4 data

Altera Corporation
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xgmii_tx_dc_[44]

xgmii_sdr_ctri[4]

Lane 4 control

xgmii_tx_dc_[52:45]

xgmii_sdr_data[47:40]

Lane 5 data

xgmii_tx_dc_[53]

xgmii_sdr_ctrl[5]

Lane 5 control

xgmii_tx_dc_[61:54]

xgmii_sdr_data[55:48]

Lane 6 data

xgmii_tx_dc_[62]

xgmii_sdr_ctrl[6]

Lane 6 control

xgmii_tx_dc_[70:63]

xgmii_sdr_data[63:56]

Lane 7 data

xgmii_tx_dc_[71]

xgmii_sdr_ctri[7]

Lane 7 control

Table 3-12: Mapping from XGMII RX Bus to the XGMII SDR Bus

xgmii_rx_dc_[7:0]

xgmii_sdr_data[7:0]

Lane 0 data

xgmii_rx_dc_[8]

xgmii_sdr_ctrl[0]

Lane 0 control

xgmii_rx_dc_[16:9]

xgmii_sdr_data[15:8]

Lane 1 data

xgmii_rx_dc_[17]

xgmii_sdr_ctri[1]

Lane 1 control

xgmii_rx_dc_[25:18]

xgmii_sdr_data[23:16]

Lane 2 data

xgmii_rx_dc_[26]

xgmii_sdr_ctri[2]

Lane 2 control

xgmii_rx_dc_[34:27]

xgmii_sdr_data[31:24]

Lane 3 data

xgmii_rx_dc_[35]

xgmii_sdr_ctrl[3]

Lane 3 control

xgmii_rx_dc_[43:36]

xgmii_sdr_data[39:32]

Lane 4 data

xgmii_rx_dc_[44]

xgmii_sdr_ctri[4]

Lane 4 control

xgmii_rx_dc_[52:45]

xgmii_sdr_data[47:40]

Lane 5 data

xgmii_rx_dc_[53]

xgmii_sdr_ctrl[5]

Lane 5 control

xgmii_rx_dc_[61:54]

xgmii_sdr_data[55:48]

Lane 6 data

xgmii_rx_dc_[62]

xgmii_sdr_ctrl[6]

Lane 6 control

xgmii_rx_dc_[70:63]

xgmii_sdr_data[63:56]

Lane 7 data

xgmii_rx_dc_[71]

xgmii_sdr_ctrl[7]

Lane 7 control

10GBASE-R PHY Status, 1588, and PLL Reference Clock Interfaces
This section describes the 10GBASE-R PHY status, 1588, and PLL reference clock interfaces.
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Table 3-13: T0GBASE-R Status, 1588, and PLL Reference Clock Outputs

rx_block_lock Output Asserted to indicate that the block synchron-
izer has established synchronization.

rx_hi_ber Output Asserted by the BER monitor block to
indicate a Sync Header high bit error rate
greater than 10,

rx_recovered_clk[<n>:0] Output This is the RX clock, which is recovered from
the received data stream.

pll_locked Output When asserted, indicates that the TX PLL is
locked.

IEEE 1588 Precision Time Protocol

rx_latency_adj_10g [15:0] Output When you enable 1588, this signal outputs
the real time latency in XGMII clock cycles
(156.25 MHz) for the RX PCS and PMA
datapath for 10G mode. Bits 0 to 9 represent
the fractional number of clock cycles. Bits 10
to 15 represent the number of clock cycles.

tx_latency adj_10g [15:0] Output When you enable 1588, this signal outputs
real time latency in XGMII clock cycles
(156.25 MHz) for the TX PCS and PMA
datapath for 10G mode. Bits 0 to 9 represent
the fractional number of clock cycles. Bits 10
to 15 represent the number of clock cycles.

PLL Reference Clock

pll_ref clk Input For Stratix IV GT devices, the TX PLL
reference clock must be 644.53125 MHz. For
Arria V and Stratix V devices, the TX PLL
reference clock can be either 644.53125 MHz
or 322.265625 MHz.

Optional Reset Control and Status Interface

This topic describes the signals in the optional reset control and status interface. These signals are available
if you do not enable the embedded reset controller.

Table 3-14: Avalon-ST RX Interface

pll_powerdown ‘ Input ‘ When asserted, resets the TX PLL.

Altera Corporation 10GBASE-R PHY IP Core
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When asserted, reset all blocks in the TX PCS. If
your design includes bonded TX PCS channels,

refer to Timing Constraints for Reset Signals when
Using Bonded PCS Channels for a SDC constraint

tx_digitalreset[<n>-1:0]

Input

you must include in your design.

tx_analogreset[<n>-1:0]

Input

When asserted, resets all blocks in the TX PMA.

Note: For Arria V devices, while compiling a
multi-channel transceiver design, you
will see a compile warning (12020) in
Intel Quartus Prime software related to
the signal width of tx_analogreset. You
can safely ignore this warning. Also,
per-channel TX analog reset is not
supported in Intel Quartus Prime
software. Channel 0 TX analog resets all

the transceiver channels.

tx_cal_busy[<n>-1:0]

Output

When asserted, indicates that the initial TX
calibration is in progress. It is also asserted if
reconfiguration controller is reset. It will not be
asserted if you manually re-trigger the calibration
IP. You must hold the channel in reset until

calibration completes.

rx_digitalreset[<n>-1:0]

Input

When asserted, resets the RX PCS.

rx_analogreset[<n>-1:0]

Input

When asserted, resets the RX CDR.

rx_cal_busy[<n>-1:0]

Output

When asserted, indicates that the initial RX
calibration is in progress. It is also asserted if
reconfiguration controller is reset. It will not be
asserted if you manually re-trigger the calibration

IP.

Related Information

« Timing Constraints for Bonded PCS and PMA Channels on page 18-11
o Transceiver Reset Control in Stratix V Devices

o Transceiver Reset Control in Arria V Devices

« Transceiver Reset Control in Cyclone V Devices

T10GBASE-R PHY Clocks for Arria V GT Devices

The following figure illustrates Arria V GT clock generation and distribution.
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Figure 3-7: Arria V GT Clock Generation and Distribution
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10GBASE-R PHY Clocks for Arria V GZ Devices

The following figure illustrates clock generation and distribution for Arria V GZ devices.

Altera Corporation
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Figure 3-8: Arria V GZ Clock Generation and Distribution
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T10GBASE-R PHY Clocks for Stratix IV Devices

The phy_mgmt_clk_reset signal is the global reset that resets the entire PHY. A positive edge on this

signal triggers a reset.

Refer to the Reset Control and Power Down chapter in volume 2 of the Stratix IV Device Handbook for

additional information about reset sequences in Stratix IV devices.

The PCS runs at 257.8125 MHz using the pma_rx_clock provided by the PMA. You must provide the
PMA an input reference clock running at 644.53725 MHz to generate the 257.8125 MHz clock.

10GBASE-R PHY IP Core
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Figure 3-9: Stratix IV Clock Generation and Distribution

10GBASE-R Transceiver Channel - Stratix IV GT

TX
-bi _bi 40 20 10.3125
64-bit data, 8-bit control > / / Gbps sera
TXPCS TXPCS TXPMA Eg
xgmii_tx_clk (soft IP) (hard IP) . >
257.8125 516625 | pll_ref_clk
MHz MHz TXPLL L 644.531254\AHZ
5/4
RX 10.3125
64-bit data, 8-pit control ¢ , 40 ) 20 Gbps serial
RX PCS RX PCS <p77
xgmii_rx_clk (soft IP) (hard IP) RXPMA
TP /2 TP
57815 L—1 516625
MHz MHz
156.25 MHz GPLL |
8/33

Related Information

Reset Control and Power Down

T10GBASE-R PHY Clocks for Stratix V Devices

The following figure illustrates clock generation and distribution in Stratix V devices.

Altera Corporation
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Figure 3-10: Stratix V Clock Generation and Distribution

10GBASE-R Hard IP Transceiver Channel - Stratix V 10GBASE-R Hard IP Transceiver Channel - Stratix V
X X
64-bit data, 8-bif control | 0 10'3125_ 64-bit data, 8-bif control 0 10'3125_
» »> Gbps serial » »> Gbps serial
xqmii_tx_ck TXPCS _ N TXPMA xqmii_tx_clk TXPCS _ N XPMA  HS———1—
73 - »> - »>
pll_ref_clk : pll_ref_clk
P 64453125Hz | | 3 P 644531250Hz |
2578125 : 2578125
MHz : MHz
1 RX 103125 : RX 103125
; 64-bit data, 8-bit control 40 Gbps serial ' 64-bit data, 8-bit control 40 Gbps serial
: oLl RXPCS ‘ RXPMA <P 3 oLl RXPCS ‘ RXPMA <P
156.25 MHz ™ 2578125 156.25 MHz w1815
MHz ' MHz
i | ncoreclkin ‘ rx_coreclkin
T fPLL | ! = fPLL |t
A <
xgmii_nx_dk ‘Wl xgmii_n_dlk ‘Wl
** Using rx_coreclkin ** Without using rx_coreclkin

To ensure proper functioning of the PCS, the maximum PPM difference between the pll1_ref_clk and
xgmi i_tx_clk clock inputs is 0 PPM. The FIFO in the RX PCS can compensate +100 PPM between the
RX PMA clock and xgmii_rx_clk. You should use xgmi i_rx_clk to drive xgmii_tx_clk. The CDR logic
recovers 257.8125 MHz clock from the incoming data.

10GBASE-R PHY Register Interface and Register Descriptions

The Avalon-MM PHY management interface provides access to the I0GBASER-R PHY PCS and PMA
registers. You can use an embedded controller acting as an Avalon-MM master to send read and write
commands to this Avalon-MM slave interface.

Table 3-15: Avalon-MM PHY Management Interface

phy_mgmt_clk Input The clock signal that controls the Avalon-MM
PHY management, interface. For Stratix IV
devices, the frequency range is 37.5-50 MHz.
There is no frequency restriction for Stratix V
devices; however, if you plan to use the same clock
for the PHY management interface and transceiver
reconfiguration, you must restrict the frequency
range of phy_mgmt_clk to 100-150 MHz to meet
the specification for the transceiver reconfigura-
tion clock.

phy_mgmt_clk_reset Input Global reset signal that resets the entire 10GBASE-
R PHY. This signal is active high and level
sensitive. This signal is not synchronized
internally.

T10GBASE-R PHY IP Core Altera Corporation
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phy_mgmt_addr[8:0] Input 9-bit Avalon-MM address.

phy_mgmt_writedata[31:0] Input Input data.

phy_mgmt_readdata[31:0] Output Output data.

phy _mgmt_write Input Write signal. Asserted high.

phy mgmt_read Input Read signal. Asserted high.

phy_mgmt_waitrequest Output When asserted, indicates that the Avalon-MM
slave interface is unable to respond to a read or
write request. When asserted, control signals to the
Avalon-MM slave interface must remain constant.

Refer to the “Typical Slave Read and Write Transfers” and “Master Transfers” sections in the “Avalon
Memory-Mapped Interfaces” chapter of the Avalon Interface Specifications for timing diagrams.

The following table specifies the registers that you can access over the Avalon-MM PHY management
interface using word addresses and a 32-bit embedded processor. A single address space provides access to

all registers.

Note: Writing to reserved or undefined register addresses may have undefined side effects.

Table 3-16: 10GBASE-R Register Descriptions

PMA Common Control and Status

0x021 [31:0]

RwW

cal_blk_powerdown

Writing a 1 to channel <n> powers
down the calibration block for
channel <n>. This register is only
available if you select Use external
PMA control and reconfig on the
Additional Options tab of the GUIL

0x022 [31:0]

RO

pma_tx_pll_is_locked

Bit[P] indicates that the TX clock
multiplier unit CMU PLL [P] is
locked to the input reference clock.
This register is only available if you
select Use external PMA control and
reconfig on the Additional Options
tab of the GUIL.

Reset Control Registers-Automatic Reset Controller

0x041 [31:0]

RW

reset_ch_bitmask

Reset controller channel bitmask for
digital resets. The default value is all 1
s. Channel <#n> can be reset when
bit<n> = 1. Channel <n> cannot be
reset when bit<n>=0.

Altera Corporation
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Writing a 1 to bit 0 initiates a TX
digital reset using the reset controller
module. The reset affects channels
enabled in the reset_ch_bitmask.
Writing a 1 to bit 1 initiates a RX
digital reset of channels enabled in the
reset_ch_bitmask. Both bits 0 and 1

0x042

[1:0]

reset_control (write)

self-clear.

RO

reset_status (read)

Reading bit 0 returns the status of the
reset controller TX ready bit. Reading
bit 1 returns the status of the reset

controller RX ready bit.

0x044

[31:0]

RW

reset_fine_control

You can use the reset_fine_control
register to create your own reset
sequence. The reset control module
performs a standard reset sequence at
power on and whenever the phy_
mgmt_clk_reset is asserted. Bits

[31:4,0] are reserved.

(31:4,0]

RW

Reserved

It is safe to write Os to reserved bits.

1]

RwW

reset_tx_digital

Writing a 1 causes the internal TX
digital reset signal to be asserted,
resetting all channels enabled in
reset_ch_bitmask. You must write a
0 to clear the reset condition.

RwW

reset_rx_analog

Writing a 1 causes the internal RX
digital reset signal to be asserted,
resetting the RX analog logic of all
channels enabled in reset_ch_
bitmask. You must write a 0 to clear

the reset condition.

RwW

reset_rx_digital

Writing a 1 causes the RX digital reset
signal to be asserted, resetting the RX

digital channels enabled in reset_ch_
bitmask. You must write a 0 to clear

the reset condition.

PMA Channel Control and Status

0x061

[31:0]

RwW

phy_serial_loopback

Writing a 1 to channel <n> puts
channel <»> in serial loopback mode.
For information about pre- or post-
CDR serial loopback modes, refer to

Loopback Modes.

T10GBASE-R PHY IP Core

C] Send Feedback

Altera Corporation


mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%2010GBASE-R%20PHY%20IP%20Core%20(UG-01080%202020.06.02)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

UG-01080

3-26 10GBASE-R PHY Register Interface and Register Descriptions 2020.06.02
0x064 [31:0] pma_rx_set_locktodata When set, programs the RX CDR PLL

to lock to the incoming data. Bit <n>
corresponds to channel <n>.

0x065 [31:0] RW pma_rx_set_locktoref When set, programs the RX CDR PLL
to lock to the reference clock. Bit <n>
corresponds to channel <n>.

0x066 [31:0] RO pma_rx_is_lockedtodata | When asserted, indicates that the RX
CDR PLL is locked to the RX data,
and that the RX CDR has changed
from LTR to LTD mode. Bit <n>
corresponds to channel <n>.

0x067 [31:0] RO pma_rx_is_lockedtoref When asserted, indicates that the RX
CDR PLL is locked to the reference
clock. Bit <n> corresponds to channel
<n>.

10GBASE-R PCS

Provides for indirect addressing of all
PCS control and status registers. Use
0x080 [31:0] WO INDIRECT_ADDR this register to specify the logical
channel number of the PCS channel
you want to access.

(2] RW RCLR_ERRBLK_CNT When set to 1, clears the error block
count register. To block: Block
synchronizer

0x081
[3] RW RCLR_BER_COUNT When set to 1, clears the bit error rate

(BER) register. To block: BER
monitor

Altera Corporation 10GBASE-R PHY IP Core
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PCS_STATUS For Stratix IV devices: When asserted
indicates that the PCS link is up.

[1] R HI_BER When asserted by the BER monitor
block, indicates that the PCS is
recording a high BER. From block:
BER monitor

[2] R BLOCK_LOCK When asserted by the block synchron-
izer, indicates that the PCS is locked
to received blocks. From Block: Block
synchronizer

(3] R TX_FIFO_FULL When asserted, indicates the TX FIFO
is full. From block: TX FIFO

(4] R RX_FIFO_FULL When asserted, indicates the RX FIFO
is full. From block: RX FIFO

0x082

(5] R RX_SYNC_HEAD_ERROR For Stratix V devices, when asserted,
indicates an RX synchronization
error. This signal is Stratix V devices
only.

[6] R RX_SCRAMBLER_ERROR For Stratix V devices: When asserted,
indicates an RX scrambler error.

[7] R RX_DATA_READY When asserted indicates that the RX
interface is ready to send out received
data. From block: 10 Gbps Receiver
PCS

[5:0] R BER_COUNT[5:0] For Stratix IV devices only, records
the bit error rate (BER). From block:
BER monitor

[13:6] R ERROR_BLOCK_COUNT[7:0] | For Stratix IV devices only, records
the number of blocks that contain
0x083 errors. From Block: Block synchron-
izer

[14] R LATCHED_HI_BER Latched version of HI_BER . From
block: BER monitor

[15] R LATCHED_BLOCK_LOCK Latched version of BLOCK_LOCK. From
Block: Block synchronizer

Related Information

« Loopback Modes on page 17-59
o Avalon Interface Specifications

10GBASE-R PHY IP Core Altera Corporation
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10GBASE-R PHY Dynamic Reconfiguration for Stratix IV Devices

The 10GBASE-R PHY includes additional top-level signals when configured with an external modules for
PMA control and dynamic reconfiguration.

You enable this configuration by turning on Use external PMA control and reconfig available for Stratix
IV GT devices.

Table 3-17: External PMA and Reconfiguration Signals

gxb_pdn Input When asserted, powers down the entire GT block.
Active high. For Stratix IV de

pll_pdn Input When asserted, powers down the TX PLL. Active high.

cal_blk_pdn Input When asserted, powers down the calibration block.
Active high.

cal_blk_clk Input Calibration clock. For Stratix IV devices only. It must

be in the range 37.5-50 MHz. You can use the same
clock for the phy_mgmt_clk and the cal_blk_clk.

pll_locked Output When asserted, indicates that the TX PLL is locked.

reconfig_to_xcvr[3:0] Input Reconfiguration signals from the Transceiver Reconfi-
guration Controller to the PHY device. This signal is
only available in Stratix IV devices.

reconfig_from_xcvr [(<n>/4) |Output Reconfiguration RAM. The PHY device drives this
17-1:0] RAM data to the transceiver reconfiguration IP. This
signal is only available in Stratix IV devices.

10GBASE-R PHY Dynamic Reconfiguration for Arria V and Stratix V
Devices

For Arria V and Stratix V devices, each channel and each TX PLL have separate dynamic reconfiguration
interfaces. The MegaWizard Plug-In Manager provides informational messages on the connectivity of
these interfaces. The example below shows the messages for a single duplex channel.

Although you must initially create a separate reconfiguration interface for each channel and TX PLL in
your design, when the Intel Quartus Prime software compiles your design, it reduces the number of
reconfiguration interfaces by merging reconfiguration interfaces. The synthesized design typically includes
a reconfiguration interface for at least three channels because three channels share an Avalon-MM slave
interface which connects to the Transceiver Reconfiguration Controller IP Core. Conversely, you cannot
connect the three channels that share an Avalon-MM interface to different Transceiver Reconfiguration
Controllers. Doing so causes a Fitter error. For more information, refer to Transceiver Reconfiguration
Controller to PHY IP Connectivity on page 17-57. Allowing the Intel Quartus Prime software to merge
reconfiguration interfaces gives the Fitter more flexibility in placing transceiver channels.

Altera Corporation 10GBASE-R PHY IP Core
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Example 3-2: Informational Messages for the Transceiver Reconfiguration Interface

Reconfiguration interface offset 0 is connected to the transceiver channel.

PHY IP will require 2 reconfiguration interfaces for connection to the external
reconfiguration controller.

Reconfiguration interface offset 0 is connected to the transceiver channel.

Reconfiguration interface offset 1 is connected to the transmit PLL.

The following table describes the signals in the reconfiguration interface; this interface uses the Avalon-

MM PHY Management interface clock.

Table 3-18: Reconfiguration Interface

n

reconfig_to_xcvr Input Reconfiguration signals from the Transceiver Reconfigura-
tion Controller. <n> grows linearly with the number of

[(<n>70-1):0] L. .. . . .
reconfiguration interfaces. This signal is only available in
Stratix V devices.

reconfig_from_xcvr Output | Reconfiguration signals to the Transceiver Reconfiguration

[(<n>46-1):0]

Controller. <n> grows linearly with the number of reconfigu-
ration interfaces. This signal is only available in Stratix V
devices.

1588 Delay Requirements

The 1588 protocol requires symmetric delays or known asymmetric delays for all external connections.

In calculating the delays for all external connections, you must consider the delay contributions of the

following elements:

o The PCB traces
o The backplane traces

o The delay through connectors

o The delay through cables

Accurate calculation of the channel-to-channel delay is important in ensuring the overall system accuracy.

T0GBASE-R PHY TimeQuest Timing Constraints

The timing constraints for Stratix IV GT designs are in alt_10gbaser_phy.sdc. If your design does not
meet timing with these constraints, use LogicLock ~ for the alt_10gbaser_pcs block. You can also apply
LogicLock to the al't_10gbaser_pcs and slightly expand the lock region to meet timing.

The following example provides the Synopsys Design Constraints file (.sdc) timing constraints for the
10GBASE-R IP Core when implemented in a Stratix IV device. To pass timing analysis, you must decouple
the clocks in different time domains. Be sure to verify the each clock domain is correctly buffered in the

T10GBASE-R PHY IP Core
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top level of your design. You can find the .sdc file in your top-level working directory. This is the same
directory that includes your top-level .v or .vhd file.

Example 3-3: Synopsys Design Constraints for Clocks

#**************************************************************

# Timing Information
#
set_time_format -unit ns -decimal_places 3
#**************************************************************
# Create Clocks

#
create_clock -name {xgmii_tx_clk} -period 6.400 -waveform { 0.000 3.200 }
[get_ports {xgmii_tx_clk}]

create_clock -name {phy_mgmt_clk} -period 20.00 -waveform { 0.000 10.000 }
[get_ports {phy_mgmt_clk}]

create_clock -name {pll_ref_clk} -period 1.552 -waveform { 0.000 0.776 }
[get_ports {ref_clk}]

#derive_pll_clocks

derive_pll_clocks -create_base_clocks

#derive_clocks -period "1.0"

# Create Generated Clocks

create_generated_clock -name pll_mac_clk -source [get_pins -compati-
bility_mode {*altpll_component]auto_generated|plll]clk[0]}]
create_generated_clock -name pma_tx_clk -source [get_pins -compati-
bility_mode {*siv_alt_pma]pma_direct]auto_generated]transmit_pcsO]clkout}]

## Set Clock Latency

#**************************************************************

# Set Clock Uncertainty
#
#**************************************************************
derive_clock_uncertainty

set_clock_uncertainty -from [get_clocks {*siv_alt_pma]pma_ch*.pma_direct]
receive_pcs*|clkout}] -to pll_ref clk -setup 0.1

set_clock_uncertainty -from [get_clocks {*siv_alt_pma]pma_direct]
auto_generated]transmit_pcsO]clkout}] -to pll_ref_clk -setup 0.08
set_clock_uncertainty -from [get_clocks {*siv_alt_pma]pma_ch*.pma_direct]
receive_pcs*|clkout}] -to pll_ref_clk -hold 0.1

set_clock_uncertainty -from [get_clocks {*siv_alt_pma|pma_direct]
auto_generated]transmit_pcsO]clkout}] -to pll_ref_clk -hold 0.08

#
# Set Input Delay

#**************************************************************

# Set Clock

set_clock _groups -exclusive -group phy_mgmt _clk -group xgmii_tx_clk -group
[get_clocks {*siv_alt_pma]pma_ch*_.pma_direct]transmit_pcs*|clkout}] -group
[get_clocks {*siv_alt_pma]pma_ch*_pma_direct]receive_pcs*|clkout}] -group
[get_clocks {*pll_siv_xgmii_clk]altpll_component]auto_generated|pll1]
clk[0]}]

H

# Set False Path

set_false_path -from {*siv_10gbaser_xcvr*clk_reset _ctrl]rx_pma_rstn} -to
[get_clocks {{*siv_alt_pma]pma_ch*.pma_direct|transmit_pcs*|clkout}
{*siv_alt_pma]pma_ch*_pma_direct]|receive_pcs*|clkout} {*pll_siv_xgmii_clk]
altpll_component]auto_generated|pll1]|clk[0]} phy_mgmt_clk xgmii_tx_clk}]
set_false_path -from {*siv_10gbaser_xcvr*clk_reset _ctrl]rx_usr_rstn} -to
[get_clocks {{*siv_alt_pma]pma_ch*_pma_direct]transmit_pcs*|clkout}

Altera Corporation 10GBASE-R PHY IP Core
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{*siv_alt_pma]pma_ch*.pma_direct]transmit_pcs*|clkout} {*pll_siv_xgmii_clk]
altpll_component]auto_generated|pll1l]|clk[0]} phy_mgmt_clk xgmii_tx_clk}]
set_false_path -from {*siv_10gbaser_xcvr*clk_reset _ctrl|tx_pma_rstn} -to
[get_clocks {{*siv_alt_pma|pma_ch*_pma_direct|receive_pcs*|clkout}
{*siv_alt_pma]pma_ch*.pma_direct]transmit_pcs*|clkout} {*pll_siv_xgmii_clk]
altpll_component]auto_generated|pll1l]|clk[0]} phy_mgmt_clk xgmii_tx_clk}]
set_false_path -from {*siv_10gbaser_xcvr*clk_reset _ctrl|tx_usr_rstn} -to
[get_clocks {{*siv_alt_pma]pma_ch*_pma_direct|receive_pcs*|clkout}
{*siv_alt_pma]pma_ch*.pma_direct]|transmit_pcs*|clkout} {*pll_siv_xgmii_clk]
altpll_component]auto_generated|pll1l]|clk[0]} phy_mgmt_clk xgmii_tx_clk}]
set_false_path -from {*siv_10gbaser_xcvr*rx_analog_rst_lego|rinit} -to
[get_clocks {{*siv_alt_pma]pma_ch*_pma_direct|receive_pcs*|clkout}
{*siv_alt_pma]pma_ch*.pma_direct]transmit_pcs*|clkout} {*pll_siv_xgmii_clk]
altpll_component]auto_generated|pll1l]|clk[0]} phy_mgmt_clk xgmii_tx_clk}]
set_false_path -from {*siv_10gbaser_xcvr*rx_digital_rst_lego|rinit} -to
[get_clocks {{*siv_alt_pma]pma_ch*_pma_direct|receive_pcs*|clkout}
{*siv_alt_pma]pma_ch*.pma_direct]transmit_pcs*|clkout} {*pll_siv_xgmii_clk]
altpll_component]auto_generated|pll1l]|clk[0]} phy_mgmt_clk xgmii_tx_clk}]

AEEAEXEAEAEAAXAAAXAAXAAAXAAXAAAXAAAXAAXAAAXAXAXAAXAAXAAAXAAAAAXAAAXAAAXAAAXAAXAAXAkX

# Set Maximum Delay

# Set Input Transition

#**************************************************************

Note: This .sdc file is only applicable to the 10GBASE-R PHY IP Core when compiled in isolation. You
can use it as a reference to help in creating your own .sdc file.

Note: For Arria V and Stratix V devices, timing constraints are built into the HDL code.

Note: The SDC timing constraints and approaches to identify false paths listed for Stratix V Native PHY
IP apply to all other transceiver PHYs listed in this user guide. Refer to SDC Timing Constraints of
Stratix V Native PHY for details.

Related Information

« SDC Timing Constraints of Stratix V Native PHY on page 13-72
This section describes SDC examples and approaches to identify false timing paths.
o About LogicLock Regions

T10GBASE-R PHY Simulation Files and Example Testbench

Refer to Running a Simulation Testbench for a description of the directories and files that the Intel
Quartus Prime software creates automatically when you generate your I0GBASE-R PHY IP Core.

Related Information
Running a Simulation Testbench on page 1-6

T10GBASE-R PHY IP Core Altera Corporation
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The Backplane Ethernet 10GBASE-KR PHY MegaCore® function is available for Stratix® V and Arria V
GZ devices.

This transceiver PHY allows you to instantiate both the hard Standard PCS and the higher performance
hard 10G PCS and hard PMA for a single Backplane Ethernet channel. It implements the functionality
described in the IEEE Std 802.3ap-2007 Standard. Because each instance of the I0GBASE-KR PHY IP
Core supports a single channel, you can create multi-channel designs by instantiating more than one
instance of the core. The following figure shows the 10GBASE-KR transceiver PHY and additional blocks
that are required to implement this core in your design.

Intel Corporation. All rights reserved. Intel, the Intel logo, Altera, Arria, Cyclone, Enpirion, MAX, Nios, Quartus and Stratix words and logos are trademarks of

Intel Corporation or its subsidiaries in the U.S. and/or other countries. Intel warrants performance of its FPGA and semiconductor products to current 1SO
specifications in accordance with Intel's standard warranty, but reserves the right to make changes to any products and services at any time without notice. ~ 9001:2015
Intel assumes no responsibility or liability arising out of the application or use of any information, product, or service described herein except as expressly Registered
agreed to in writing by Intel. Intel customers are advised to obtain the latest version of device specifications before relying on any published information

and before placing orders for products or services.

*Other names and brands may be claimed as the property of others.

JALTERAN

101 Innovation Drive, San Jose, CA 95134 now part of Intel


https://www.altera.com/servlets/subscriptions/alert?id=UG-01080
mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20(UG-01080%202020.06.02)%20Backplane%20Ethernet%2010GBASE-KR%20PHY%20IP%20Core&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html

4-2 Backplane Ethernet 10GBASE-KR PHY IP Core

Figure 4-1: 10GBASE-KR PHY MegaCore Function and Supporting Blocks
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The Backplane Ethernet I0GBASE-KR PHY IP Core includes the following new modules to enable
operation over a backplane:

« Link Training (LT)— The LT mechanism allows the 10GBASE-KR PHY to automatically configure the
link-partner TX PMDs for the lowest Bit Error Rate (BER). LT is defined in Clause 72 of IEEE Std

802.3ap-2007.

 Auto negotiation (AN)—The Altera I0GBASE-KR PHY IP Core can auto-negotiate between
1000BASE-KX (1GbE) and 10GBASE-KR (10GbE) PHY types. The AN function is mandatory for
Backplane Ethernet. It is defined in Clause 73 of the IEEE Std 802.3ap-2007.

o Forward Error Correction—Forward Error Correction (FEC) function is an optional feature defined in
Clause 74 of IEEE 802.3ap-2007. It provides an error detection and correction mechanism allowing
noisy channels to achieve the Ethernet-mandated Bit Error Rate (BER) of 10712

Related Information

IEEE Std 802.3ap-2007 Standard

Altera Corporation

Backplane Ethernet 10GBASE-KR PHY IP Core
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10GBASE-KR PHY Release Information

Table 4-1: 10GBASE-KR PHY Release Information

e i

Version

13.1

Release Date

November 2013

Ordering Codes IP-10GBASEKR PHY (primary)
Product ID 0106
Vendor ID 6AF7

Device Family Support

IP cores provide either final or preliminary support for target Altera device families. These terms have the

following definitions:

o Final support—Verified with final timing models for this device.
o Preliminary support—Verified with preliminary timing models for this device.

Table 4-2: Device Family Support

Device Family m Supported Speed Grades

Arria V GZ devices-Hard PCSand | Final I3L, C3, 14, C4

PMA

Stratix V devices-Hard PCS and Final All speed grades except 14 and C4
PMA

Other device families No support

Altera verifies that the current version of the Intel Quartus Prime software compiles the previous version
of each IP core. Any exceptions to this verification are reported in the MegaCore IP Library Release
Notes and Errata. Altera does not verify compilation with IP core versions older than the previous release.

Note: For speed grade information, refer to DC and Switching Characteristics for Stratix V Devices in the

Stratix V Device Datasheet.

Related Information
Stratix V Device Datasheet

10GBASE-KR PHY Performance and Resource Utilization

This topic provides performance and resource utilization for the IP core in Arria V GZ and Stratix V

devices.

Backplane Ethernet 10GBASE-KR PHY IP Core
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The following table shows the typical expected resource utilization for selected configurations using the
current version of the Intel Quartus Prime software targeting a Stratix V GT (5SGTMC7K2F40C2) device.
The numbers of ALMs and logic registers are rounded up to the nearest 100. Resource utilization numbers
reflect changes to the resource utilization reporting starting in the Quartus II software v14.1 release for 28
nm device families and upcoming device families.

Table 4-3: 10GBASE-KR PHY Performance and Resource Utilization

10GBASE-KR PHY only, no AN or LT

10GBASE-KR PHY with AN and 1000 1700 0
Sequencer

10GBASE-KR PHY with LT and Sequencer, | 2100 2300 0
10GBASE-KR PHY with AN, LT, and 2700 3300 0
Sequencer

10GBASE-KR MIF, Port A depth 256, 0 0 1 (M20K)

width 16, ROM (For reconfiguration from
low latency or 1GbE mode)

Low Latency MIF, Port A depth 256, width |0 0 1 (M20K)
16, ROM (Required for auto-negotiation
and link training.)

10GBASE-KR PHY with FEC 3700 5100 40 (M20K)

Parameterizing the T0GBASE-KR PHY

Thel0GBASE-KR PHY IP Core is available for the Arria V GZ and Stratix V device families. The IP
variant allows you specify either the Backplane-KR or 1Gb/10Gb Ethernet variant. When you select the
Backplane-KR variant, the Link Training (LT) and Auto Negotiation (AN) tabs appear. The 1Gb/10Gb
Ethernet variant (1G/10GbE) does not implement LT and AN parameters.

Complete the following steps to configure the I0GBASE-KR PHY IP Core:

1. Under Tools > IP Catalog, select the device family of your choice.

2. Under Tools > IP Catalog > Interface Protocols > Ethernet, select 10GBASE-KR PHY.

3. Use the tabs on the MegaWizard Plug-In Manager to select the options required for the protocol.

4. Specify 10GBASE-KR parameters. Refer to the topics listed as Related Links to understand 10GBASE-
KR parameters.

5. Click Finish to generate your parameterized 10GBASE-KR PHY IP Core.

Related Information

o 10GBASE-KR Link Training Parameters on page 4-5

Altera Corporation Backplane Ethernet 10GBASE-KR PHY IP Core
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« 10GBASE-KR Auto-Negotiation and Link Training Parameters on page 4-6
o 10GBASE-R Parameters on page 4-7
« 1GDbE Parameters on page 4-8

o Speed Detection Parameters on page 4-9

« PHY Analog Parameters on page 4-10

10GBASE-KR Link Training Parameters

The 10GBASE-KR variant provides parameters to customize the Link Training parameters.

Table 4-4: Link Training Settings

I T

Enable Link Training

On/Off

When you turn this option On, the core includes the
link training module which configures the remote
link-partner TX PMD for the lowest Bit Error Rate
(BER). LT is defined in Clause 72 of IEEE Std

802.3ap-2007.

Enable daisy chain mode

On/Off

When you turn this option On, the core includes
support for non-standard link configurations where
the TX and RX interfaces connect to different link
partners. This mode overrides the TX adaptation

algorithm.

Enable microprocessor
interface

On/Off

When 